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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

การเปลี่ยนค่าเริ่มต้นของหน่วยวัดใน InDesign CS6 
 

 เปิดโปรแกรม InDesign CS6 

 เปิดเมนู Edit 

 เลือกรายการ Preferences 

 เลือกรายการ Units & Increments... 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 ก าหนดค่า Horizontal ในกรอบ Ruler Units เป็น Inches 

 ก าหนดค่า Vertical ในกรอบ Ruler Units เป็น Inches 

 คลิก (click) OK 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 ที่ Welcome screen คลิก (click) Document เพื่อสรา้งเอกสารใหม่ 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 คลิก (click) ที่ปุ่ม More Options 
จะเห็นว่าหน่วยวัดที่อยูใ่นกรอบ New Document เป็น in (Inches) ดังภาพ 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

การก าหนดค่าเร่ิมต้นของเอกสาร 
 

 เปิดเมนู File 

 เลือกรายการ New 

 เลือกรายการ Documents จะปรากฏดังภาพ 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 ก าหนด Number of Pages เป็น 6 

 disable “Facing Pages” (ปิดการใช้งาน น าเครื่องหมาย  ออกจากช่อง ) 

 ก าหนด Width เป็น 5.031 in 

 ก าหนด Height เป็น 10 in 

 ก าหนด Margins (เส้นระยะขอบ) เป็น 0.25 in 

 ก าหนด Bleed (ระยะตดัตก) เป็น 0.125 in 

 คลิก (click) OK 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 จะได้เอกสารใหม่เป็นแนวตั้ง 

 กด Ctrl + เครือ่งหมายลบ (–) เพือ่ Zoom out 

 จะพบว่ามีเอกสารทั้งหมด 6 หน้า ดังภาพ 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 เปิดพาแนล Pages 

 จะเห็นว่าไอคอนของแตล่ะหน้าเรียงกันตามแนวตั้ง ดังภาพ 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 เปิดเมนูของพาแนล Pages (ไอคอนทีมุ่มบนขวาของพาแนล) 

 เลือกรายการ View Pages 

 เลือก Horizontally 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 ที่พาแนล Pages จะเหน็วา่ไอคอนของแต่ละหน้า ถูกก าหนดให้เรียงกัน 
ตามแนวนอน ดังภาพ 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 เปิดเมนูของพาแนล Pages (ไอคอนทีมุ่มบนขวาของพาแนล) 

 Disable (ปิดการใช้งาน) “Allow Document Pages to Shuffle” 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 ที่พาแนล Pages 

 ลากไอคอน Page 2 ไปชิดด้านขวาของไอคอน Page 1 

 ลากไอคอน Page 3 ไปชิดด้านขวาของไอคอน Page 2 

 ลากไอคอน Page 5 ไปชิดด้านขวาของไอคอน Page 4 

 ลากไอคอน Page 6 ไปชิดด้านขวาของไอคอน Page 5 

 จะได้เอกสาร 2 หน้า ทีแ่ต่ละหน้ามี 3 หน้าย่อยอยู่ติดกัน ดังภาพ 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

การก าหนดขนาดหน้ากระดาษของแผ่นพบัที่ถกูพับเข้าด้านใน 
 

 ใช้เทคนิคการสร้าง Master Page ใหม่ ให้ขนาดหน้ากระดาษที่ถูกพับเข้าด้านใน
มีขนาดเล็กกว่าปกติ แล้วก าหนดให้หน้าที่จะถูกพับเข้าด้านในใช้ Master Page นี ้

 เปิดพาแนล Pages 

 ลากไอคอนรูปหน้าที่อยู่ด้านขวาของ A-Master ไป ทับไอคอน Create new page 
เพื่อสร้าง Master Page ใหม่ จะได้ Master Page ใหม่ชื่อ B-Master ดังภาพ 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 double click (คลิก) ทีช่ื่อ B-Master 

 กด ctrl + alt + 0 (เลขศูนย์) เพื่อจัดกึ่งกลาง 

 เลือกไอคอน Page Tool จากกล่องเครื่องมือ (Toolbox) ด้านซ้าย (ไอคอนที่ 3 จากบน) 

 เลื่อนเมาส์ (mouse) มาคลิก (click) ที่กลางหน้าเอกสาร 

 ก าหนด W เป็น 4.937 แล้วกดแท็บ (ได้จากการเอาขนาดความกว้างเดิม คูณ 2 
แล้วลบออก 15 จะได้ขนาดหน้าที่เหลือ แล้วตัดออก 0.001) 

 เลือก Selection Tool แล้ว clear selection 
 

      ก าหนด  W = 4.937  
 

   เลือกไอคอน Page Tool ไอคอนที่ 3 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 ในพาแนล Pages 

 double click (คลิก) ที่ชื่อหน้า 1-3 เพื่อไปที่หน้า 1-3 

 ลากไอคอนหน้าของ B-Master ไปทับเฉพาะไอคอน หน้า 1 (ซ้ายสุด) 

 จะมีกรอบข้อความเด้งขึ้นมาถาม ใหเ้ลือก “Use master page size” 

 จะพบปัญหาว่ามีช่องว่างเกิดข้ึนในเอกสารระหว่างหน้า 1 กับหน้า 2 
 

 
 
 
 
 
 
     ช่องว่างในเอกสาร 
     ระหว่างหน้า 1 กับหน้า 2 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 ในพาแนล Pages 

 ลากไอคอนหน้า 1 ไปไว้ชิดทางขวาของไอคอนหน้า 3  ผลลัพธ์คือ ช่องว่าง
ระหวา่งหน้าจะหายไป แต่การเรียงหน้าจะเรียงผิดล าดับ 

 ให้ลากไอคอนหน้า 1 กลับมาชิดทางซ้ายของไอคอนหน้า 2 

 เลือกไอคอน Page Tool 

 คลิก (click) ที่แต่ละหน้าเพื่อดูความกว้าง หน้าที่อยู่ด้านซ้ายสุดจะต้องมีขนาดเล็ก
กว่าอีก 2 หน้าที่เหลือ โดยไม่มีช่องว่างเกิดขึ้นระหว่างหน้า และในพาแนล Pages 
จะต้องเรียงล าดับหน้า 1-3 และ B A A ดังภาพ 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 ในพาแนล Pages 

 double click (คลิก) ที่ชื่อหน้า 4-6 เพื่อไปที่หน้า 4-6 

 ลากไอคอนหน้าของ B-Master ไปทับเฉพาะไอคอน หน้า 6 (ด้านขวาสุด) 

 จะมีกรอบข้อความเด้งข้ึนมาถาม ให้เลือก “Use master page size” 

 เลือกไอคอน Page Tool คลิก (click) ที่แต่ละหน้าเพื่อดูความกว้าง หน้าที่อยู่
ด้านขวาสุดจะต้องมีขนาดเล็กกว่าอีก 2 หน้าที่เหลือ โดยไม่มีช่องว่างเกิดขึ้นระหว่างหน้า 
และในพาแนล Pages จะต้องเรียงล าดับหน้า 4-6 เป็น A A B 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

การสร้าง Grid (เส้นร่างก าหนดระยะ) 
 

 double click (คลิก) ทีช่ื่อ A-Master 

 เปิดเมนู Layout 

 เลือก Margins and Columns... 

 ก าหนด Columns Number เป็น 3 

 ก าหนด Columns Gutter เป็น 0.125 in 

 คลิก (click) OK 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 เปิดเมนู Layout 

 เลือก Create Guides... 

 ก าหนด Rows Number เป็น 4 

 ก าหนด Rows Gutter เป็น 0.125 in 

 ก าหนด Columns Number เป็น 3 

 ก าหนด Columns Gutter เป็น 0.125 in 

 จะเห็นว่าเส้น Columns (คอลัมน์) ไม่ตรงกับเส้นคอลัมน์ของหน้าที่ถูกแบ่งเอาไว้ 
จะต้องเปลี่ยน Fit Guides to เป็น Margins 

 คลิก (click) OK 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 double click (คลิก) ทีช่ื่อ B-Master 

 เปิดเมนู Layout 

 เลือก Margins and Columns... 

 ก าหนด Columns Number เป็น 3 

 ก าหนด Columns Gutter เป็น 0.125 in 

 คลิก (click) OK 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 เปิดเมนู Layout 

 เลือก Create Guides. 

 ก าหนด Rows Number เป็น 4 

 ก าหนด Rows Gutter เป็น 0.125 in 

 ก าหนด Columns Number เป็น 3 

 ก าหนด Columns Gutter เป็น 0.125 in 

 จะเห็นว่าเส้น Columns ไม่ตรงกับเส้นคอลัมน์ของหน้าที่ถูกแบ่งเอาไว้ จะต้อง
เปลี่ยน Fit Guides to เป็น Margins 

 คลิก (click) OK 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

การน าเข้ากราฟิกและรปูภาพส าหรบัแผ่นพับ 
 

 เปิดพาแนล Pages 

 double click (คลิก) ทีเ่ลขหนา้ 1-3 ซึ่งในตัวอย่างนีก้ าหนดให้หน้าหมายเลข 3 
เป็นหน้าปกของแผ่นพับ 
 

 
 
 
 
 

                       หน้า 1                      หน้า 2                       หน้า 3 
         (ปกแผ่นพับ) 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 ดาวน์โหลดไฟล์กราฟิกและรูปภาพที่ต้องการใช้ในแผ่นพับ ซึ่งไฟล์ เวกเตอร์ 
(Vector) ใช้สกุลไฟล์ .ai ต้องเปิดด้วยโปรแกรม Adobe Illustrator ส่วนรูปภาพ 
(images) ใช้สกุลไฟล์ .jpeg, .jpg, .png  

 ในกรณีใช้ไฟล์เวกเตอร์ ใน Adobe Illustrator ไฟล์ Vector ส่วนใหญ่จะสร้างขึ้น
ด้วยการรวมกลุ่มไฟล์ ดังนั้นต้อง Ungroup ด้วยการคลิก (click) เมาส์ (mouse) ขวา 
เลือก Ungroup เพื่อให้ไฟล์งานแยกออกจากกัน 

 คลิก (click) Selection tool (ลูกศรสีด า) แล้วคลิก (click) ครอบเลือกไฟล์
วัตถุที่ต้องการน ามาใช้ 

 กด ctrl + c เพื่อ copy ดังภาพตัวอย่าง 
 

     เปิดไฟล์ Vector ใน Adobe Illustrator 
     คลิก Selection tool (ลูกศรสีด า) เลือกวัตถุทั้งช้ิน 

 

 
 
 
 

  
  กด ctrl + c เพื่อ copy 

 
                  คลิกเมาส์ขวา เลือก Ungroup 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 กลับมาที่ Adobe InDesign CS6 

 กด ctrl + v เพื่อวางไฟล์เวกเตอร์ แล้วจัดวางตกแต่งตามความต้องการ ดังภาพตัวอยา่ง 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 ในกรณีใช้รูปภาพ (images) สกุลไฟล์ .jpeg, .jpg, .png สามารถลากรูปภาพ
เข้าโปรแกรม Adobe InDesign CS6 ได้เลย 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 การน าเข้ารูปภาพอีกวิธหีนึ่ง ไปที่ Menu File > Place (ค าสั่งการแทรกภาพ) 

 เลือกรูปภาพที่ต้องการแล้วคลิก (click) Open 

 แล้วคลิก (click) ลงบนพื้นที่ที่ต้องการน าภาพมาวาง 
 

 
 



   27 

  

ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 การปรับขนาดรูปภาพให้คลิก (click) ที่รูปภาพ จะปรากฏเฟรม (Frame) รูปภาพ 
หากลดหรือขยายขนาดเฟรม รูปภาพจะไม่ปรับขนาดตาม เมื่อปรับขนาดรูปภาพแล้ว 
ต้องคลิกเมาส ์(mouse) ขวา เลือก fitting > fit content to frame รูปภาพจึงจะปรบัขนาด
ตามเฟรมที่ก าหนดไว้  
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 การใส่ภาพพื้นหลังในแต่ละหน้าของแผ่นพับ ในกรณีที่สร้างเฟรมขึ้นมาก่อน 
แล้วน ารูปภาพใส่ในเฟรม ให้เลือก Rectangle Frame Tool 

 ลากกรอบเฟรมรูปภาพให้เต็มหน้าที่ 3 หรือหน้าอื่น ๆ ที่ต้องการ ให้คลอบคลุม
Bleed (ระยะตัดตก) 

 
                 Bleed (ระยะตัดตก) ของแผ่นพับ 

 

 
 

 
 
 
 
 
 

                                     กรอบเฟรมรูปภาพ 
                             ที่สร้างขึ้น 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 เลือก Selection Tool (ไอคอนลูกศรสีด า) ล าดับแรกของแถบกล่องเครื่องมือ 
(Toolbox) ด้านซ้ายมือ 

 คลิก (click) เมาส์ (mouse) ขวา ที่กรอบเฟรมสี่เหลี่ยมที่สร้างขึ้น 

 เลือกรายการ Arrange 

 เลือก Send to Back 
 

 Selection Tool .ใช้เลือกวัตถุ 
  

        
       แถบกล่องเครื่องมือ (Toolbox) 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 เปิดเมนู File 

 เลือกรายการ Place... 

 เลือกไฟล์ประเภทต่าง ๆ เช่น  photoshop สก ุล ไฟล ์ .PSD หรือรูปภาพ 
(images) สกุลไฟล์ .jpeg, .jpg, .png ในโฟลเดอร์หรือแหล่งจัดเก็บข้อมูล 

 คลิก (click) Open เพือ่น าข้าไฟล ์
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 ภาพจะเขา้ไปอยู่ในเฟรมที่สรา้งขึ้น ดังภาพตัวอย่าง 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 เลือก Selection Tool 

 เลื่อนเมาส์มาที่กลางเฟรมภาพหน้าปก 

 จะเห็นไอคอนกลมในวงสีแดงปรากฏขึ้น ไอคอนนี้เรียกว่า Content Grabber 
ใช้ในการปรับแต่งภาพที่อยู่ในเฟรม 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 คลิก (click) ที่ไอคอน Content Grabber 

 กด ctrl + เครื่องหมายลบ (–) เพื่อ zoom out จนกระทั่งเห็นกรอบภาพทั้งหมด 

 ปรับขนาดภาพโดยกด Shift ค้างไว้ แล้วลากที่ มุมล่างด้านขวาของกรอบภาพ 
จนเส้นขอบด้านล่างของภาพทับเส้น Bleed (ระยะตัดตก) ดังภาพ 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 กด ctrl + alt + 0 (ศูนย์) เพื่อจัดกึ่งกลางหน้าเอกสาร 

 ปรับต าแหน่งของภาพ ด้วยการกดเลื่อนลูกศรขึ้น ลง ซ้าย ขวา ที่แป้นพิมพ์ จนได้
ต าแหน่งของภาพที่ต้องการในเฟรม 

 คลิก (click) ที่ pasted board เพื่อ clear selection 

 ใส่รูปภาพ ข้อความ และตกแต่งทุกหน้าของแผ่นพับตามรูปแบบที่ต้องการ 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

การปรับแต่งและการจัดวางข้อความ 
 

 หัวใจส าคัญของโปรแกรม Adobe InDesign นอกจากการใช้จัดหน้ากระดาษแล้ว 
การใส่ตัวอักษรและจัดวางองค์ประกอบรวม เพราะชิ้นงานส่วนใหญ่เป็นงานพิมพ์
เผยแพร่ ตัวอักษรจึงมีความส าคัญมากในงานออกแบบแผ่นพับ 
 
การสร้างตัวอักษร 

 คลิก (click) เลือกเครื่องมือ Text Frame ( ) เลือกรูปแบบ Frame ที่ต้องการ 
ซึ่งมีให้เลือก 3 รูปแบบ คือ สี่เหลี่ยม วงกลม และหลายเหลี่ยม 

 คลิก (click) ลากขนาดกล่องข้อความตามต้องการ 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 พิมพ์ข้อความใน Frame โดยใช้เครือ่งมอื Type Tool ( ) ซึ่งมีให้เลือก 4 รปูแบบ 
ได้แก ่

  1) Me type tool ใช้พิมพ์ข้อความธรรมดาจากซ้ายไปขวา 
  2) Me type on a path tool ใช้พมิพ์ตัวอักษรบนเสน้ path จากซ้ายไปขวา 
  3) Type Tool ใช้พิมพ์ข้อความธรรมดา  
  4) Type on a Path Tool ใช้สร้างและแก้ไขตัวอักษรบนเส้น Path 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 ใช้เครื่องมือ Selection ( ) ปรับขนาด Frame ให้พอดีกับข้อความกรณีที่มี
เครื่องหมายบวกที่ Frame แสดงว่าใน Frame นั้นยังซ่อนข้อความไว้อีก 

 คลิก (click) ลากขนาดตามต้องการ 
 

 
 



   39 

  

ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

เครื่องมือในการปรับแต่งตัวอักษรจากคอนโทรลพาเนล 
 1. Character Formatting Controls ควบคุมการท างานของตัวอักษร ซึ่งมี
รูปแบบการใช้งานในการจัดข้อความที่หลากหลาย ดังนี้ 

 

 
 

 หมายเลข 1  Font (รูปแบบตัวอักษร)  
 หมายเลข 2  Type Style (ลักษณะตัวอักษร) 
 หมายเลข 3  Font Size (ขนาดตัวอักษร) 
 หมายเลข 4  Leading (ระยะห่างของตัวอักษร) 
 หมายเลข 5  All Cap (เปลี่ยนเป็นตัวภาษาอังกฤษพิมพ์ใหญ่)  
   Small Caps (เปลี่ยนเป็นตัวภาษาอังกฤษพิมพ์ใหญ่ขนาดเล็ก)  
   Superscript (ตัวอักษรยก)  
   Subscript (ตัวอักษรห้อย)  
   Underline (ขีดเส้นใต้ตัวอักษร)  
   Stikethrough (ขีดเส้นคร่อมตัวอักษร)  
 หมายเลข 6  Kerning (ปรับช่องไฟของตัวอักษร)  
   Trackpng (ปรับช่องไฟทั้งข้อความ)  
 หมายเลข 7  Vertical Scale (เพ่ิม/ลดความสูงตัวอักษร) 
   Horizontal Scale (เพ่ิม/ลดความกว้างตัวอักษร)  
   Baseline (ยก/ห้อยตัวอักษร)  
   Skew (อักษรตัวเอียง) 
 หมายเลข 8  Fill (สีตัวอักษร)  
   Stroke (สีเส้นขอบตัวอักษร) 
 หมายเลข 9  Align left (จัดเรียงข้อความชิดซ้าย) 
   Align center (จัดเรียงข้อความตรงกลาง) 
   Align right (จัดเรียงข้อความชิดขวา) 
   Justtify with last line aligned left (เหยียดเต็ม บรรทัดสุดท้ายชิดซ้าย) 
   Justtify with last line aligned center (เหยยีดเต็ม บรรทัดสุดท้ายตรงกลาง) 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 
    Justtify with last line aligned right (เหยียดเต็ม บรรทัดสุดท้ายชิดขวา) 

   Justify all lines (จัดเรียงข้อความเหยียดเต็มทุกบรรทัด) 
   Align towards spine (จัดเรียงข้อความชิดด้านฝั่งหยักน้อย) 

    Align away from spine (จัดเรียงข้อความชิดด้านฝั่งหยักมาก) 

 
 2. Parageaph Formatting Controls ควบคุมการท างานของย่อหน้าซึ่ งมี
รูปแบบการใช้งานในการจัดข้อความที่หลากหลาย ดังนี้ 
 

 
 

 หมายเลข 1 Align left (จัดเรียงข้อความชิดซ้าย) 
   Align center (จัดเรียงข้อความตรงกลาง) 
   Align right (จัดเรียงข้อความชิดขวา) 
   Justtify with last line aligned left (เหยียดเต็ม บรรทัดสุดท้ายชิดซ้าย) 
   Justtify with last line aligned center (เหยยีดเต็ม บรรทัดสุดท้ายตรงกลาง) 
   Justtify with last line aligned right (เหยียดเต็ม บรรทัดสุดท้ายชิดขวา) 
   Justtify all lines (จัดเรียงข้อความเหยียดเต็มทุกบรรทัด) 
   Align towards spine (จัดเรียงข้อความชิดด้านฝั่งหยักน้อย) 
   Align away from spine (จัดเรียงข้อความชิดด้านฝั่งหยักมาก) 
 หมายเลข 2 Left-to-Right Paragraph Direction (ทิศทางย่อหน้าจากซ้ายไปขวา) 
   Right-to-Left Paragraph Direction (ทิศทางย่อหน้าจากซ้ายไปขวา) 
 หมายเลข 3 Left indent (เยื้องซ้าย) 
   Right indent (เยื้องขวา) 
   first line indent (บรรทัดแรกเยื้อง) 
   last line indent (เยื้องบรรทัดสุดท้าย) 
 หมายเลข 4  space before (พ้ืนที่ก่อน) 
   space after (พ้ืนที่หลัง) 
   drop cap number of line (จ านวนตัวหล่นของบรรทัด) 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 
   drop cap one more character (ลดลงอีกหนึ่งตัวอักษร) 
 หมายเลข 5 Bullet list (รายการหัวข้อย่อย) 
   Numbers list (รายการตัวเลข) 
 หมายเลข 6 Paragraph style (รูปแบบย่อหน้า) 
 หมายเลข 7 Do not alian to baseline grid (อย่าอยู่ในเส้นตารางพ้ืนฐาน) 

    Alian to baseline grid (จัดแนวให้เป็นเส้นตารางพื้นฐาน) 
 หมายเลข 8  Numbers of columns (จ านวนคอลัมน์) 
   Gutter (ระยะห่างระหว่างคอลัมน์) 
   Span columns (ระยะคอลัมน์) 
   Horizontal carsor position (ต าแหน่งเคอร์เซอร์ในแนวนอน) 
 หมายเลข 9  Font (รูปแบบตัวอักษร)  
   Type Style (ลักษณะตัวอักษร) 
   Font Size (ขนาดตัวอักษร) 

    Leading (ระยะห่างของตัวอักษร) 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

การจัดระยะห่าง (ช่องไฟ) ของตัวอักษร 
 หลังจากเลือกใช้ฟอนต์ได้ถูกใจแล้ว หากต้องการจัดข้อความแบบชิดขอบซ้ายและ
ขอบขวา (Justify) ให้สวยงาม ให้ตั้งค่าตามขั้นตอนดังน้ี 

 

 ไปที่ Type > Paragraph Style หรือกดคีย์ F11 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 จากนั้นจะมีกล่อง Panel แสดงขึ้นมา คลิก (click) เลือก Style Options... 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 ไปที่ค าสั่ง Justification 

 ก าหนดค่าในช่องว่าง ดงันี ้
  Word Spacing 70%, 100%, 150%  
  Letter Spacing -5%, 0%, 25%  
  Glyph Spacing  100%, 100%, 100% 

 ก าหนด Composer เป็น Adobe World-Ready Paragraph Composer 

 คลิก (click) OK 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

การเปลี่ยนสีข้อความ 
 การเปลี่ยนสีข้อความเป็นการท าให้ข้อความนั้นมีลักษณะเด่น มองเห็นง่ายและท าให้
ชิ้นงานหรือสื่อสิ่งพิมพ์มีความสวยงามอีกด้วย 
 

 คลิก (click) เลือก Type Tool เลือกข้อความที่ต้องการเปลี่ยนสี 

 คลิก (click) เลือกที่เมนู Window > Color หรือกดคีย์ F6 

 คลิก (click) เลือกโทนสีที ่เหมาะสมกับงานและสามารถคลิกค้างเลื่อนแถบ 
เพื่อปรับผสมความเข้มข้นของแม่สี 

 คลิกเมาส์ที่ OK ข้อความที่เลือกไว้จะเปลี่ยนสีตามต้องการ 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

การใส่สีขอบ (Stroke) ข้อความ 
 การใส่สีขอบข้อความเป็นการท าให้ข้อความนั้นมีมิติ เน้นข้อความ มองเห็นง่าย
และท าให้ชิ้นงานหรือสื่อสิ่งพิมพ์มีความสวยงาม น่าสนใจยิ่งขึ้น 
 

 คลิก (click) เลอืกที่เมนู Window > Color หรือกดคีย์ F6 

 คลิก (click) เลอืก press shift of alternate panal เพื่อเลือกส ี

 คลิก (click) เลอืกโทนสทีี่เหมาะสมกับข้อความ 

 คลิก (click) เลอืกรูปแบบเส้นขอบที่ต้องการ ดังนี ้
  1) Weight (ขนาดของเส้น) 
  2) Miter Join (ลดขนาดมุมเส้นขอบ) 
  3) Round Join (ปรับเส้นขอบให้โค้งมน) 
  4) Bevel Join (ปรับเส้นขอบให้มีมุมเอยีง) 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 ข้อความที่เลือกไว้จะเปลี่ยนสีตามต้องการ ดังภาพ 
 

 
 
การข้ึนต้นย่อหน้าด้วยตัวอักษรขนาดใหญ ่

 คลิก (click) เลือก Type Tool คลิกเมาส์ลงในต าแหน่งใดก็ได้ของย่อหน้าที่ต้องการ
ขยายขนาดตัวอักษรตัวแรก 

 คลิก (click) เลือกที่เมนู Type > Paragroph หรือกดคีย์ Alt+Ctrl+T 

 ก าหนดขนาดตัวอักษรเป็นจ านวนบรรทัดและตัวอักษรตัวแรกของย่อหน้า
จะขยายขนาดใหญ่ ตามจ านวนบรรทัดที่ก าหนด 

 จะได้ตัวอักษรขึ้นต้นขนาดใหญ่ตามที่ต้องการ 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

การคัดลอกข้อความจากไฟล์โปรแกรม Microsoft Word 
 โปรแกรมส่วนใหญ่ที่มักใช้ในการสร้างข้อความ คือ Microsoft Word ซึ่งใน
โปรแกรม Adobe InDesign สามารถน าข้อความจาก Microsoft Word มาใช้งานได้ 
เพื่อความสะดวกยิ่งขึ้น ดังนี้ 
 

 ไปที่ค าสั่ง File 

 เลือก Place 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 เลือกไฟล์ที่ตอ้งการ 

 คลิก (click) เลอืก Open 

 
 

 ข้อความจากไฟล์ Microsoft Word จะเข้ามาในโปรแกรม Adobe InDesign 

 



   50 

  

ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

การบันทึกไฟล์แผน่พับ 
 

 เปิดเมนู File 

 เลือกรายการ Save 

 เลือกโฟลเดอร์ Desktop หรือโฟลเดอร์อื่นที่ต้องการ Save ไฟล์งาน 

 ก าหนดชื่อไฟล์ที่ต้องการ 

 เลือก Save as type เป็น “InDesign cs6 document” จะได้ไฟล์นามสกุล .indd  

 คลิก (click) เครื่องหมาย  Always Save Preview Images with Documents 

 คลิก (click) Save 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

การ Export File เพื่อน าไปใช ้
 
การ Export File เป็น .PDF .JPEG 

 คลิก (click) ที่เมนู File เลือก Export หรอืกด Ctrl+E ทีแ่ป้นพิมพ ์
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 เลือกโฟลเดอร์ที่ต้องการเก็บไฟล์ Export จากนั้นตั้งชื่อไฟล์งาน แล้วเลือก
ประเภทไฟล์ที่ต้องการ Export 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 ในกรณีที่เลอืก Export File เป็น .PDF ให้ตั้งค่าแต่ละหัวขอ้ ดังน้ี 
  1) คลิก (click) ที่ General 
  2) Adobe PDF Preset ตั้งค่าเป็น High Quality. Print (modified) 
  3) Standard ตั้งค่าเป็น PDF/X-4:2010 
  4) Compatibility ตั้งคา่เป็น Acrobat 7 (PDF 1.6) 

 คลิก (click) Export 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

 ในกรณีที่เลอืก Export File เป็น .PDF เพื่อส่งโรงพิมพ ์ให้ตั้งค่าเพิ่มเติม ดังน้ี 
  1) คลิก (click) ที่ Marks and Bleeds 
  2) Marks ให้ท าเครื่องหมาย  ในช่อง  ทกุหัวข้อ  

 3) Bleed and Slug ก าหนดค่า Bleed ทุกหัวข้อเป็น 3 mm หรือ 0.3 cm 
 4) ท าเครื่องหมาย  ในช่อง  Use Document Bleed Settings 

 คลิก (click) Export 
 

 
 

รายการอ้างอิง 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 

รายการอ้างอิง 
 

ธนัชสร จิตต์เนื่อง. (2556). คู่มือใช้งาน InDesign CS6. กรุงเทพฯ: สวัสดี ไอที. 
อดิศักดิ์ คงสัตย์. (2552). คัมภีร์ Adobe Indesign CS4 : คู่มือสร้างสื่อสิ่งพิมพ์อย่าง

มืออาชีพ. กรุงเทพฯ: โปรวิชั่น. 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 
 
 
 
 
 
 
 

ภาคผนวก 
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ฝ่ายพัฒนางานวิจยัและบริการวิชาการ 
คณะมนุษยศาสตร์และสังคมศาสตร์ มหาวิทยาลัยราชภัฏสวนสุนันทา 

 
 
 
 
 
 
 

ภาคผนวก ก 
ตัวอย่างแผ่นพับฉบับสมบูรณ ์

 
 
 
 
 
 



½†ÒÂ¾Ñ²¹Ò§Ò¹ÇÔ¨ÑÂáÅÐºÃÔ¡ÒÃÇÔªÒ¡ÒÃ
¤³ÐÁ¹ØÉÂÈÒÊµÃ�áÅÐÊÑ§¤ÁÈÒÊµÃ� ÁËÒÇÔ·ÂÒÅÑÂÃÒªÀÑ®ÊÇ¹ÊØ¹Ñ¹·Ò





 Ê¹ÑºÊ¹Ø¹à¡ÉµÃ¡Ãä·Â
µŒÍ§ãªŒ»Ø‰ÂÍÔ¹·ÃÕÂ�ÍÑ´àÁ็´

»Ø‰ÂÍÔ¹·ÃÕÂ�ÍÑ´àÁ็´
»Ø‰Â´ÕÁÕ»ÃÐâÂª¹�
THE BENEFITS OF ORGANIC FERTILIZER PELLETS

1. »ÅÍ´ÀÑÂµ‹Í¼ÙŒãªŒáÅÐÊÔ่§áÇ´ÅŒÍÁ

2. ÁÕ¸ÒµØÍÒËÒÃÁÒ¡¡Ç‹Ò»Ø‰ÂÊ´ 5 à·‹Ò 

3. Å´¡ÅÔ่¹áÅÐÂÑ§¤§¤Ø³¤‹Ò¢Í§»Ø‰ÂÍÔ¹·ÃÕÂ�

4. »Ø ‰ÂÍÔ¹·ÃÕÂ�ÍÑ´àÁ็´ÊÒÁÒÃ¶à¡็ºäÇŒãªŒä´Œ¹Ò¹ 
à¾ÃÒÐàËÅ×Í¤ÇÒÁª×้¹à¾ÕÂ§ 10 % ¨ÐäÁ‹ÁÕàª× ้ÍÃÒ
·Õ่à»š¹ÊÒàËµØ¢Í§¡ÒÃà¡Ô´¡ÅÔ่¹àËÁ็¹

5. Å´¡ÒÃãªŒ»Ø‰Âà¤ÁÕ ·ÓãËŒ»ÃÐËÂÑ´µŒ¹·Ø¹

»Ø‰ÂÍÔ¹·ÃÕÂ�ÍÑ´àÁ็´
¡ÅØ‹Áá»Å§ãËÞ‹µŒ¹áººÊŒÁâÍ

facebook: ÇÔÊÒË¡Ô¨ªØÁª¹ÊŒÁâÍ¢ÒÇãËÞ‹ µ.ºÒ§¹Ò§ÅÕ่ 

+668 5177 4497

àÅ¢·Õ่ 47 ËÁÙ‹·Õ่ 3 µÓºÅºÒ§¹Ò§ÅÕ่
ÍÓàÀÍÍÑÁ¾ÇÒ ¨Ñ§ËÇÑ´ÊÁØ·ÃÊ§¤ÃÒÁ

CONTACT:

O R G A N I C  F E R T I L I Z E R  P E L L E T S

½†ÒÂ¾Ñ²¹Ò§Ò¹ÇÔ¨ÑÂáÅÐºÃÔ¡ÒÃÇÔªÒ¡ÒÃ
¤³ÐÁ¹ØÉÂÈÒÊµÃ�áÅÐÊÑ§¤ÁÈÒÊµÃ� ÁËÒÇÔ·ÂÒÅÑÂÃÒªÀÑ®ÊÇ¹ÊØ¹Ñ¹·Ò

ÇÔÊÒË¡Ô¨ªØÁª¹
ÊŒÁâÍ¢ÒÇãËÞ‹ µ.ºÒ§¹Ò§ÅÕ่



“»Ø‰ÂÍÔ¹·ÃÕÂ�ÍÑ´àÁ็´
»Ø‰Â¸ÃÃÁªÒµÔ
à¾×่Íà¡ÉµÃ¡Ãä·Â
à¾×่Íà¡ÉµÃ¡ÃâÅ¡” O R G A N I C  F E R T I L I Z E R  P E L L E T S

N AT U R A L  F E R T I L I Z E R
T O  FA R M E R S ,  T H A I L A N D
T O  FA R M E R S  T H E  W O R L D

¤Ø³ÀÒ¾ÍÑ´á¹‹¹·Ø¡àÁ็´

·ÓäÁ...
µŒÍ§ãªŒ»Ø‰ÂÍÔ¹·ÃÕÂ�ÍÑ´àÁ็´?

ÁÒÃÙŒ¨Ñ¡
»Ø‰ÂÍÔ¹·ÃÕÂ�
»Ø‰Â¸ÃÃÁªÒµÔà¾×่Í¾×ª¢Í§¤Ø³

»Ø‰ÂÍÔ¹·ÃÕÂ� ä´Œ¨Ò¡ÇÑÊ´ØÍÔ¹·ÃÕÂ� ¼ÅÔµ´ŒÇÂÇÔ¸Õ·ÓãËŒ
ª×¹้ ÊÑº ËÁÑ¡ º´ Ã‹Í¹ Ê¡Ñ́  ËÃ×Í Œ́ÇÂÇÔ̧ Õ¡ÒÃÍ×¹่ ÇÑÊ Ǿ 
ÍÔ¹·ÃÕÂ�̈ Ð¶Ù¡Â‹ÍÂÊÅÒÂÊÁºÙÃ³�́ ŒÇÂ Ø̈ÅÔ¹·ÃÕÂ� áµ‹äÁ‹ãª‹ 
»Ø‰Âà¤ÁÕáÅÐ»Ø‰ÂªÕÇÀÒ¾ ª¹Ô´¢Í§»Ø‰ÂÍÔ¹·ÃÕÂ�
àª‹¹ »Ø‰Â¤Í¡ »Ø‰Â¾×ªÊ´ »Ø‰ÂËÁÑ¡ à»š¹µŒ¹ 
«Ö่§»˜¨¨ØºÑ¹ÁÕ¡ÒÃ¹Óà·¤â¹âÅÂÕÁÒãªŒ
¼ÅÔµ»Ø‰ÂÍÔ¹·ÃÕÂ�ÍÑ´àÁ็´ ¼‹Ò¹
¡ÃÃÁÇÔ¸Õ¡ÒÃ¦‹Òàª×้Í´ŒÇÂÇÔ¸Õ
ÍºäÍ¹้Ó ª‹ÇÂÅ´¡ÅÔ่¹
áÅÐÊÒÃ¾ÔÉ ¡ÒÃà¡ÉµÃã¹»˜¨¨ØºÑ¹¹ÔÂÁãªŒ»Ø ‰Âà¤ÁÕ¡Ñ¹

ÍÂ‹Ò§á¾Ã‹ËÅÒÂ ·ÓãËŒ´Ô¹àÊ×่ÍÁÊÀÒ¾áÅÐà»š¹
ÍÑ¹µÃÒÂµ‹ÍÊØ¢ÀÒ¾¢Í§¼ÙŒºÃÔâÀ¤áÅÐà¡ÉµÃ¡Ã 
¡ÒÃãªŒ»Ø‰ÂÍÔ¹·ÃÕÂ�ÍÑ´àÁ็´¨Ö§à»š¹·Ò§àÅ×Í¡·Õ่´Õ
ã¹¡ÒÃÃÑ¡ÉÒÊÀÒ¾ Ố¹ à¹×Í่§¨Ò¡ãËŒ̧ ÒµØÍÒËÒÃá¡‹¾×ª 
ºÓÃØ§´Ô¹ãËŒÁÕÊÀÒ¾´Õ àËÁÒÐá¡‹¡ÒÃà¨ÃÔÞàµÔºâµ 
¢Í§¾×ª ¹Ñºà»š¹à·¤â¹âÅÂÕ·Õ¶่Ù¡µŒÍ§áÅÐàËÁÒÐÊÁ
«Ö ่§¨Ðª‹ÇÂÅ´ÁÅÀÒÇÐãËŒá¡‹·ŒÍ§¶Ô ่¹ áÅÐà¡Ô´ 
ÇÔÊÒË¡Ô¨ªØÁª¹·Õ่¾Ö่§µ¹àÍ§ä´Œ



F R U I T  P R O C E S S I N G
T H A I  C O M M U N I T Y  P R O D U C T  S TA N D A R

ÇÔ¸Õ·Ó
à»Å×Í¡ÊŒÁâÍàª×่ÍÁ
How to make a candied pomelo peel 

»Í¡¼ÔÇà»Å×Í¡ÊŒÁâÍ (ãªŒà©¾ÒÐÊÕ¢ÒÇ) ÅŒÒ§ãËŒÊÐÍÒ´ 
áÅŒÇËÑ่¹à»š¹ªÔ้¹ÊÕ่àËÅÕ่ÂÁ¾Í¤Ó

¹Óà»Å×Í¡ÊŒÁâÍä»µŒÁ ¹ÓÁÒ¢ÂÓÅŒÒ§´ŒÇÂ¹ÓÊÐÍÒ´

µÑ้§¡ÃÐ·ÐãªŒä¿áÃ§»Ò¹¡ÅÒ§ ãÊ‹¹้Ó´Í¡äÁŒÊ´
¹้ÓµÒÅ·ÃÒÂ ¹้Óà´×Í´ãËŒãÊ‹à»Å×Í¡ÊŒÁâÍ
à¤Õ่ÂÇ¨¹¹้ÓµÒÅ¨Ñºà»Å×Í¡ÊŒÁâÍ 

à»Å×Í¡ÊŒÁâÍàª×่ÍÁ
Candied Pomelo Peel 

+668 9913 2629

No. 46, Village No. 9,
Amphawa Samut Songkhram, Thailand

CONTACT:

08 9913 2629

áª‹à»Å×Í¡ÊŒÁâÍã¹¹้ÓÊÐÍÒ´ ¢ÂÓàºÒæ ãËŒ¤ÅÒÂÃÊ½Ò´
¹Óà»Å×Í¡ÊŒÁâÍáª‹ã¹¹้Ó»Ù¹ãÊ 3 ªÑ่ÇâÁ§

µÒ¡á´´ãËŒáËŒ§ à¡็ºãÊÀÒª¹Ð

à»Å×Í¡ÊŒÁâÍàª×่ÍÁ µÃÒÈÃÕ»ÃÐä¾
àÅ¢·Õ่ 46 ËÁÙ‹ 9 µÓºÅàËÁ×Í§ãËÁ‹
ÍÓàÀÍÍÑÁ¾ÇÒ ¨Ñ§ËÇÑ´ÊÁØ·ÃÊ§¤ÃÒÁ 75110

ornzy2524@hotmail

ÁÒµÃ°Ò¹ ÍÂ.
STANDARD FDA APPROVED

75-2-00149-2-0004
½†ÒÂ¾Ñ²¹Ò§Ò¹ÇÔ¨ÑÂáÅÐºÃÔ¡ÒÃÇÔªÒ¡ÒÃ
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“¨Ò¡ÊŒÁâÍ¢ÒÇãËÞ‹...ÊŒÁâÍáÁ‹¡ÅÍ§
ÊÙ‹à»Å×Í¡ÊŒÁâÍàª×่ÍÁ

¡Ô¹§ ‹ ÒÂ
 ä´ Œ»ÃÐâÂª¹ �

Natural Bene�ts Produces

fruit-peels exhibit di�erent biological
and medicinal properties. 
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 Ê¹ÑºÊ¹Ø¹à¡ÉµÃ¡Ãä·Â
µŒÍ§ãªŒ»Ø‰ÂÍÔ¹·ÃÕÂ�ÍÑ´àÁ็´

»Ø‰ÂÍÔ¹·ÃÕÂ�ÍÑ´àÁ็´
»Ø‰Â´ÕÁÕ»ÃÐâÂª¹�
THE BENEFITS OF ORGANIC FERTILIZER PELLETS

1. »ÅÍ´ÀÑÂµ‹Í¼ÙŒãªŒáÅÐÊÔ่§áÇ´ÅŒÍÁ

2. ÁÕ¸ÒµØÍÒËÒÃÁÒ¡¡Ç‹Ò»Ø‰ÂÊ´ 5 à·‹Ò 

3. Å´¡ÅÔ่¹áÅÐÂÑ§¤§¤Ø³¤‹Ò¢Í§»Ø‰ÂÍÔ¹·ÃÕÂ�

4. »Ø ‰ÂÍÔ¹·ÃÕÂ�ÍÑ´àÁ็´ÊÒÁÒÃ¶à¡็ºäÇŒãªŒä´Œ¹Ò¹ 
à¾ÃÒÐàËÅ×Í¤ÇÒÁª×้¹à¾ÕÂ§ 10 % ¨ÐäÁ‹ÁÕàª× ้ÍÃÒ
·Õ่à»š¹ÊÒàËµØ¢Í§¡ÒÃà¡Ô´¡ÅÔ่¹àËÁ็¹

5. Å´¡ÒÃãªŒ»Ø‰Âà¤ÁÕ ·ÓãËŒ»ÃÐËÂÑ´µŒ¹·Ø¹

»Ø‰ÂÍÔ¹·ÃÕÂ�ÍÑ´àÁ็´
¡ÅØ‹Áá»Å§ãËÞ‹µŒ¹áººÊŒÁâÍ

facebook: ÇÔÊÒË¡Ô¨ªØÁª¹ÊŒÁâÍ¢ÒÇãËÞ‹ µ.ºÒ§¹Ò§ÅÕ่ 

+668 5177 4497

àÅ¢·Õ่ 47 ËÁÙ‹·Õ่ 3 µÓºÅºÒ§¹Ò§ÅÕ่
ÍÓàÀÍÍÑÁ¾ÇÒ ¨Ñ§ËÇÑ´ÊÁØ·ÃÊ§¤ÃÒÁ

CONTACT:

O R G A N I C  F E R T I L I Z E R  P E L L E T S

½†ÒÂ¾Ñ²¹Ò§Ò¹ÇÔ¨ÑÂáÅÐºÃÔ¡ÒÃÇÔªÒ¡ÒÃ
¤³ÐÁ¹ØÉÂÈÒÊµÃ�áÅÐÊÑ§¤ÁÈÒÊµÃ� ÁËÒÇÔ·ÂÒÅÑÂÃÒªÀÑ®ÊÇ¹ÊØ¹Ñ¹·Ò

ÇÔÊÒË¡Ô¨ªØÁª¹
ÊŒÁâÍ¢ÒÇãËÞ‹ µ.ºÒ§¹Ò§ÅÕ่
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“»Ø‰ÂÍÔ¹·ÃÕÂ�ÍÑ´àÁ็´
»Ø‰Â¸ÃÃÁªÒµÔ
à¾×่Íà¡ÉµÃ¡Ãä·Â
à¾×่Íà¡ÉµÃ¡ÃâÅ¡” O R G A N I C  F E R T I L I Z E R  P E L L E T S

N AT U R A L  F E R T I L I Z E R
T O  FA R M E R S ,  T H A I L A N D
T O  FA R M E R S  T H E  W O R L D

¤Ø³ÀÒ¾ÍÑ´á¹‹¹·Ø¡àÁ็´

·ÓäÁ...
µŒÍ§ãªŒ»Ø‰ÂÍÔ¹·ÃÕÂ�ÍÑ´àÁ็´?

ÁÒÃÙŒ¨Ñ¡
»Ø‰ÂÍÔ¹·ÃÕÂ�
»Ø‰Â¸ÃÃÁªÒµÔà¾×่Í¾×ª¢Í§¤Ø³

»Ø‰ÂÍÔ¹·ÃÕÂ� ä´Œ¨Ò¡ÇÑÊ´ØÍÔ¹·ÃÕÂ� ¼ÅÔµ´ŒÇÂÇÔ¸Õ·ÓãËŒ
ª×¹้ ÊÑº ËÁÑ¡ º´ Ã‹Í¹ Ê¡Ñ́  ËÃ×Í Œ́ÇÂÇÔ̧ Õ¡ÒÃÍ×¹่ ÇÑÊ Ǿ 
ÍÔ¹·ÃÕÂ�̈ Ð¶Ù¡Â‹ÍÂÊÅÒÂÊÁºÙÃ³�́ ŒÇÂ Ø̈ÅÔ¹·ÃÕÂ� áµ‹äÁ‹ãª‹ 
»Ø‰Âà¤ÁÕáÅÐ»Ø‰ÂªÕÇÀÒ¾ ª¹Ô´¢Í§»Ø‰ÂÍÔ¹·ÃÕÂ�
àª‹¹ »Ø‰Â¤Í¡ »Ø‰Â¾×ªÊ´ »Ø‰ÂËÁÑ¡ à»š¹µŒ¹ 
«Ö่§»˜¨¨ØºÑ¹ÁÕ¡ÒÃ¹Óà·¤â¹âÅÂÕÁÒãªŒ
¼ÅÔµ»Ø‰ÂÍÔ¹·ÃÕÂ�ÍÑ´àÁ็´ ¼‹Ò¹
¡ÃÃÁÇÔ¸Õ¡ÒÃ¦‹Òàª×้Í´ŒÇÂÇÔ¸Õ
ÍºäÍ¹้Ó ª‹ÇÂÅ´¡ÅÔ่¹
áÅÐÊÒÃ¾ÔÉ ¡ÒÃà¡ÉµÃã¹»˜¨¨ØºÑ¹¹ÔÂÁãªŒ»Ø ‰Âà¤ÁÕ¡Ñ¹

ÍÂ‹Ò§á¾Ã‹ËÅÒÂ ·ÓãËŒ´Ô¹àÊ×่ÍÁÊÀÒ¾áÅÐà»š¹
ÍÑ¹µÃÒÂµ‹ÍÊØ¢ÀÒ¾¢Í§¼ÙŒºÃÔâÀ¤áÅÐà¡ÉµÃ¡Ã 
¡ÒÃãªŒ»Ø‰ÂÍÔ¹·ÃÕÂ�ÍÑ´àÁ็´¨Ö§à»š¹·Ò§àÅ×Í¡·Õ่´Õ
ã¹¡ÒÃÃÑ¡ÉÒÊÀÒ¾ Ố¹ à¹×Í่§¨Ò¡ãËŒ̧ ÒµØÍÒËÒÃá¡‹¾×ª 
ºÓÃØ§´Ô¹ãËŒÁÕÊÀÒ¾´Õ àËÁÒÐá¡‹¡ÒÃà¨ÃÔÞàµÔºâµ 
¢Í§¾×ª ¹Ñºà»š¹à·¤â¹âÅÂÕ·Õ¶่Ù¡µŒÍ§áÅÐàËÁÒÐÊÁ
«Ö ่§¨Ðª‹ÇÂÅ´ÁÅÀÒÇÐãËŒá¡‹·ŒÍ§¶Ô ่¹ áÅÐà¡Ô´ 
ÇÔÊÒË¡Ô¨ªØÁª¹·Õ่¾Ö่§µ¹àÍ§ä´Œ
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F R U I T  P R O C E S S I N G
T H A I  C O M M U N I T Y  P R O D U C T  S TA N D A R

ÇÔ¸Õ·Ó
à»Å×Í¡ÊŒÁâÍàª×่ÍÁ
How to make a candied pomelo peel 

»Í¡¼ÔÇà»Å×Í¡ÊŒÁâÍ (ãªŒà©¾ÒÐÊÕ¢ÒÇ) ÅŒÒ§ãËŒÊÐÍÒ´ 
áÅŒÇËÑ่¹à»š¹ªÔ้¹ÊÕ่àËÅÕ่ÂÁ¾Í¤Ó

¹Óà»Å×Í¡ÊŒÁâÍä»µŒÁ ¹ÓÁÒ¢ÂÓÅŒÒ§´ŒÇÂ¹ÓÊÐÍÒ´

µÑ้§¡ÃÐ·ÐãªŒä¿áÃ§»Ò¹¡ÅÒ§ ãÊ‹¹้Ó´Í¡äÁŒÊ´
¹้ÓµÒÅ·ÃÒÂ ¹้Óà´×Í´ãËŒãÊ‹à»Å×Í¡ÊŒÁâÍ
à¤Õ่ÂÇ¨¹¹้ÓµÒÅ¨Ñºà»Å×Í¡ÊŒÁâÍ 

à»Å×Í¡ÊŒÁâÍàª×่ÍÁ
Candied Pomelo Peel 

+668 9913 2629

No. 46, Village No. 9,
Amphawa Samut Songkhram, Thailand

CONTACT:

08 9913 2629

áª‹à»Å×Í¡ÊŒÁâÍã¹¹้ÓÊÐÍÒ´ ¢ÂÓàºÒæ ãËŒ¤ÅÒÂÃÊ½Ò´
¹Óà»Å×Í¡ÊŒÁâÍáª‹ã¹¹้Ó»Ù¹ãÊ 3 ªÑ่ÇâÁ§

µÒ¡á´´ãËŒáËŒ§ à¡็ºãÊÀÒª¹Ð

à»Å×Í¡ÊŒÁâÍàª×่ÍÁ µÃÒÈÃÕ»ÃÐä¾
àÅ¢·Õ่ 46 ËÁÙ‹ 9 µÓºÅàËÁ×Í§ãËÁ‹
ÍÓàÀÍÍÑÁ¾ÇÒ ¨Ñ§ËÇÑ´ÊÁØ·ÃÊ§¤ÃÒÁ 75110

ornzy2524@hotmail

ÁÒµÃ°Ò¹ ÍÂ.
STANDARD FDA APPROVED

75-2-00149-2-0004
½†ÒÂ¾Ñ²¹Ò§Ò¹ÇÔ¨ÑÂáÅÐºÃÔ¡ÒÃÇÔªÒ¡ÒÃ

¤³ÐÁ¹ØÉÂÈÒÊµÃ�áÅÐÊÑ§¤ÁÈÒÊµÃ� ÁËÒÇÔ·ÂÒÅÑÂÃÒªÀÑ®ÊÇ¹ÊØ¹Ñ¹·Ò
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“¨Ò¡ÊŒÁâÍ¢ÒÇãËÞ‹...ÊŒÁâÍáÁ‹¡ÅÍ§
ÊÙ‹à»Å×Í¡ÊŒÁâÍàª×่ÍÁ

¡Ô¹§ ‹ ÒÂ
 ä´ Œ»ÃÐâÂª¹ �

Natural Bene�ts Produces

fruit-peels exhibit di�erent biological
and medicinal properties. 

Ê‹Ç¹»ÃÐ¡Íº

à»Å×Í¡ÊŒÁâÍ
»ÃÐâÂª¹�
¨Ò¡¸ÃÃÁªÒµÔËÇÒ¹ à»ÃÕ้ÂÇ ÍÃ‹ÍÂµÔ´ÅÔ้¹”

ã¹µÓÃÒ¨Õ¹ãªŒà»š¹ÂÒá¡Œ¸ÒµØäÁ‹»¡µÔ 
ª‹ÇÂá¡ŒÍÒ¡ÒÃäÍ

á¡ŒÍÒ¡ÒÃÇÔ§àÇÕÂ¹ÈÕÃÉÐ Ë¹ŒÒÁ×´µÒÅÒÂ ã¨ÊÑ่¹

á¡ŒâÃ¤ÅÁ¾ÔÉ·Õ่¼ÔÇË¹Ñ§

á¡Œ»Ç´·ŒÍ§¹ŒÍÂáÅÐäÊŒàÅ×่Í¹ á¡Œ¨Ø¡àÊÕÂ´á¹‹¹à¿‡Í 
á¡ŒÍÒà¨ÕÂ¹

ª‹ÇÂ¢ÑºÅÁã¹ÅÓäÊŒáÅÐ¡ÃÐà¾ÒÐÍÒËÒÃ
à»Å×Í¡ÊŒÁâÍ 1 ¡ÔâÅ¡ÃÑÁ 
¹้ÓµÒÅ·ÃÒÂ 1 ¡ÔâÅ¡ÃÑÁ 
¹้Ó´Í¡äÁŒÊ´ 7 ¶ŒÇÂ 
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